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Overview
The Lexmark Distributed Intelligent Capture system has two parts:

• Intelligent Data Extraction (IDE) engine—This is composed of the project and learnset created from the
Distiller.

• Distributed Capture Platform—This is the workflow solution created from the software development kit
(SDK).

This document is intended to guide the integration of the two parts, the IDE engine and the Distributed Capture
Platform. The following skills are essential for integrating these parts:

• A thorough knowledge of the Distiller, especially its workflow for a document, and solution authoring by
way of the WinWrap script engine

• A general understanding of the basics of solution authoring by way of the SDK, including submitting jobs
to Lexmark Distributed Intelligent Capture using the job submission application programming interface
(JSAPI)
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Getting started

Installing the Distributed Capture Platform
To install the Distributed Capture Platform, see the "Installing Lexmark Distributed Intelligent Capture" section
of the Lexmark Distributed Intelligent Capture Administrator's Guide.

Installing the IDE engine
1 Insert the CD into the computer where the Distiller and Lexmark Distributed Intelligent Capture are installed.

2 Follow the instructions on the computer screen.

Note: For more information on installing the IDE engine, see the Intelligent Data Extraction Install Guide.

Understanding the integration process
The integration process can occur at these integration points:

• The Distributed Capture Platform submits a file to the IDE engine as a file drop.

• The IDE engine submits a file to the Distributed Capture Platform as a file drop that is being watched by the
directory watcher service.

• The IDE engine submits a file to the Distributed Capture Platform as a file drop that is being watched by a
scripted (Job Submission) directory watching code.

• The IDE engine submits a file to the Distributed Capture Platform using the JSAPI.

The expected most common implementation is customizing the export event in the IDE engine so that it
automatically sends the classification and extraction results to the Distributed Capture Platform. Another
expected implementation is sending the entire workdoc (.wdc) file to the Distributed Capture Platform, and then
instructing it to parse the workdoc file. However, there is no sample script for parsing the workdoc file, so this
requires writing your own script.
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Configuring the engines

Setting the correct DLL file for your project
Make sure the project you created in the IDE Engine references the correct Dynamic Link Library (DLL) file.

1 In Distiller, open Script View for Project.

2 Click Edit > References.

3 From the Available References section, scroll down and select Microsoft Scripting Runtime (1.0), and then
click OK.

Creating a script for an export event
The Distiller may already contain a default script for exporting documents. Configure the default script so that
the Distiller exports the documents into the Lexmark Distributed Intelligent Capture database by calling the
JSAPI. The JSAPI starts the scripted task and passes metadata and the original scanned file as a Tagged Image
File Format (TIFF) file.

1 In Distiller, open Script View for Project, and then load the ExportDocument event.

2 Replace the following script with your own script.

Private Sub ScriptModule_ExportDocument(pWorkdoc As SCBCdrPROJLib.SCBCdrWorkdoc, 
ByVal ExportPath As String, 
pCancel As Boolean

Notes:

• For an example of an export script, see “Sample script for an export event” on page 7.

• Make sure the pWorkdoc object can access all of the document classification and extraction results. For
more information, see the Scripting Guide.

Creating a script for a customized workflow
You may configure the IDE engine to automatically send the output results to a preset folder in the Distributed
Capture Platform.

1 Open Distiller Designer, and then click View > Definition Mode.

2 From the Classes tab, select your project, and then click Edit > Show DocClass > Edit Script.

Note: Make sure your project uses the correct DLL file. For more information, see “Setting the correct
DLL file for your project” on page 5.

3 On the Script sheet, write the script to customize your workflow.

Creating a profile in Distributed Capture Platform
Create a profile in Distributed Capture Platform so that it can accept the requests from the IDE engine and
execute the script.
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To create a profile, see "Creating and populating software client groups" in the Lexmark Distributed Intelligent
Capture Administrator's Guide.

Note: In step 4 of the topic "Adding software clients to a software client group," type the IP address of the
server where Lexmark Distributed Intelligent Capture is installed.
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Appendix

Sample script for an export event
Public Function fnJSAPIProfileCall(ByVal profileName As String, 
pWorkdoc As SCBCdrPROJLib.SCBCdrWorkdoc)
   Dim SOAPResponse, XML

   SOAPResponse = fnJSAPIStart(profileName, pWorkdoc)

   ' Parse START response
   Set XML = CreateObject("Microsoft.XMLDOM")
   XML.setProperty "SelectionLanguage", "XPath"
   XML.async = False
   XML.loadXML(SOAPResponse)

   Dim names, values
   Set names = XML.selectNodes("//name")
   Set values = XML.selectNodes("//value")

   Dim key, sessionID, scanUrl, tomcatIP, webdavUser, webdavPasswd
   Dim idx
   For idx=0 To names.length-1
      key = names(idx).Text

      If key = "sessionID" Then
         sessionID = values(idx).Text
      ElseIf key = "tomcatIP" Then
         tomcatIP = values(idx).Text
      ElseIf key = "scanUrl" Then
         scanUrl = values(idx).Text
      ElseIf key = "webdavUser" Then
         webdavUser = values(idx).Text
      ElseIf key = "webdavPasswd" Then
         webdavPasswd = values(idx).Text
      End If
   Next

   ' Optionally put the original tiff to the correct webdav folder 
   ' location for processing by the script being run.
   Dim doWebDavPut As Boolean   
   doWebDavPut = True ' hardcoded True for this example
   If doWebDavPut Then
      Dim http, fNameWithoutExt, fName, fileObject, fileBytes
      ' Original tiff file
      fNameWithoutExt = Left(pWorkdoc.Filename, CStr(Len(pWorkdoc.Filename) - 3))
      fName = fNameWithoutExt & "tif"

      ' Load tif bytes
      Set fileObject = CreateObject("ADODB.Stream")
      fileObject.type = 1
      fileObject.Open
      fileObject.LoadFromFile fName

      fileBytes = fileObject.Read

      ' webdav put bytes
      Set http = CreateObject("MSXML2.XMLHTTP.3.0")
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      http.Open "PUT", scanUrl & "/scan.0.file.0.tif", False, webdavUser, webdavPasswd
      http.setRequestHeader "translate", "f" ' Set this to prevent stream problems
      http.Send fileBytes ' Send the stream across
   End If

   fnJSAPIMetadata(sessionID, scanUrl, tomcatIP)
End Function
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Edition notice
July 2014
The following paragraph does not apply to any country where such provisions are inconsistent with local
law: LEXMARK INTERNATIONAL, INC., PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of
express or implied warranties in certain transactions; therefore, this statement may not apply to you.
This publication could include technical inaccuracies or typographical errors. Changes are periodically made
to the information herein; these changes will be incorporated in later editions. Improvements or changes in the
products or the programs described may be made at any time.
References in this publication to products, programs, or services do not imply that the manufacturer intends to
make these available in all countries in which it operates. Any reference to a product, program, or service is
not intended to state or imply that only that product, program, or service may be used. Any functionally
equivalent product, program, or service that does not infringe any existing intellectual property right may be
used instead. Evaluation and verification of operation in conjunction with other products, programs, or services,
except those expressly designated by the manufacturer, are the user’s responsibility.
For Lexmark technical support, visit http://support.lexmark.com.

For information on supplies and downloads, visit www.lexmark.com.
© 2014 Lexmark International, Inc.

All rights reserved.

Trademarks
Lexmark and the Lexmark logo are trademarks or registered trademarks of Lexmark International, Inc., 
registered in the United States and/or other countries.

All other trademarks are the property of their respective owners.

GOVERNMENT END USERS
The Software Program and any related documentation are "Commercial Items," as that term is defined in 48
C.F.R. 2.101, "Computer Software" and "Commercial Computer Software Documentation," as such terms are
used in 48 C.F.R. 12.212 or 48 C.F.R. 227.7202, as applicable. Consistent with 48 C.F.R. 12.212 or 48 C.F.R.
227.7202-1 through 227.7207-4, as applicable, the Commercial Computer Software and Commercial Software
Documentation are licensed to the U.S. Government end users (a) only as Commercial Items and (b) with only
those rights as are granted to all other end users pursuant to the terms and conditions herein.

The Apache Software License, Version 1.1
Copyright (c) 2000-2002 The Apache Software Foundation. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

1 Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2 Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3 The end-user documentation included with the redistribution, if any, must include the following
acknowledgment:
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"This product includes software developed by the Apache Software Foundation (http://www.apache.org/)."

Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party
acknowledgments normally appear.

4 The names "Apache" and "Apache Software Foundation", "Jakarta-Oro" must not be used to endorse or
promote products derived from this software without prior written permission. For written permission, please
contact apache@apache.org.

5 Products derived from this software may not be called "Apache" or "Jakarta-Oro", nor may "Apache" or
"Jakarta-Oro" appear in their name, without prior written permission of the Apache Software Foundation.

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

====================================================================

This software consists of voluntary contributions made by many individuals on behalf of the Apache Software
Foundation. For more information on the Apache Software Foundation, please see http://www.apache.org/

Apache License Version 2.0, January 2004
http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1 Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections
1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the
License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by,
or are under common control with that entity. For the purposes of this definition, "control" means (i) the
power, direct or indirect, to cause the direction or management of such entity, whether by contract or
otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial
ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modifications, including but not limited to software
source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form,
including but not limited to compiled object code, generated documentation, and conversions to other
media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the
License, as indicated by a copyright notice that is included in or attached to the work (an example is provided
in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from)
the Work and for which the editorial revisions, annotations, elaborations, or other modifications represent,
as a whole, an original work of authorship. For the purposes of this License, Derivative Works shall not
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include works that remain separable from, or merely link (or bind by name) to the interfaces of, the Work
and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor
for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized to submit on
behalf of the copyright owner. For the purposes of this definition, "submitted" means any form of electronic,
verbal, or written communication sent to the Licensor or its representatives, including but not limited to
communication on electronic mailing lists, source code control systems, and issue tracking systems that are
managed by, or on behalf of, the Licensor for the purpose of discussing and improving the Work, but
excluding communication that is conspicuously marked or otherwise designated in writing by the copyright
owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has
been received by Licensor and subsequently incorporated within the Work.

2 Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license
to reproduce, prepare Derivative Works of, publicly display, publicly perform, sublicense, and distribute the
Work and such Derivative Works in Source or Object form.

3 Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby grants
to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this
section) patent license to make, have made, use, offer to sell, sell, import, and otherwise transfer the Work,
where such license applies only to those patent claims licensable by such Contributor that are necessarily
infringed by their Contribution(s) alone or by combination of their Contribution(s) with the Work to which
such Contribution(s) was submitted. If You institute patent litigation against any entity (including a cross-
claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work
constitutes direct or contributory patent infringement, then any patent licenses granted to You under this
License for that Work shall terminate as of the date such litigation is filed.

4 Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in any
medium, with or without modifications, and in Source or Object form, provided that You meet the following
conditions:

a (a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

b (b) You must cause any modified files to carry prominent notices stating that You changed the files; and

c (c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent,
trademark, and attribution notices from the Source form of the Work, excluding those notices that do not
pertain to any part of the Derivative Works; and

d (d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You
distribute must include a readable copy of the attribution notices contained within such NOTICE file,
excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the
following places: within a NOTICE text file distributed as part of the Derivative Works; within the Source
form or documentation, if provided along with the Derivative Works; or, within a display generated by
the Derivative Works, if and wherever such third-party notices normally appear. The contents of the
NOTICE file are for informational purposes only and do not modify the License. You may add Your own
attribution notices within Derivative Works that You distribute, alongside or as an addendum to the
NOTICE text from the Work, provided that such additional attribution notices cannot be construed as
modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or different
license terms and conditions for use, reproduction, or distribution of Your modifications, or for any such
Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work otherwise
complies with the conditions stated in this License.
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5 Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally submitted
for inclusion in the Work by You to the Licensor shall be under the terms and conditions of this License,
without any additional terms or conditions. Notwithstanding the above, nothing herein shall supersede or
modify the terms of any separate license agreement you may have executed with Licensor regarding such
Contributions.

6 Trademarks. This License does not grant permission to use the trade names, trademarks, service marks, or
product names of the Licensor, except as required for reasonable and customary use in describing the origin
of the Work and reproducing the content of the NOTICE file.

7 Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides the
Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR
CONDITIONS OF ANY KIND, either express or implied, including, without limitation, any warranties or
conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE.
You are solely responsible for determining the appropriateness of using or redistributing the Work and
assume any risks associated with Your exercise of permissions under this License.

8 Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence), contract,
or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) or agreed
to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, special,
incidental, or consequential damages of any character arising as a result of this License or out of the use
or inability to use the Work (including but not limited to damages for loss of goodwill, work stoppage,
computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor
has been advised of the possibility of such damages.

9 Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof, You
may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other liability
obligations and/or rights consistent with this License. However, in accepting such obligations, You may act
only on Your own behalf and on Your sole responsibility, not on behalf of any other Contributor, and only if
You agree to indemnify, defend, and hold each Contributor harmless for any liability incurred by, or claims
asserted against, such Contributor by reason of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate notice, with the fields enclosed by
brackets "[]" replaced with your own identifying information. (Don't include the brackets!) The text should be
enclosed in the appropriate comment syntax for the file format. We also recommend that a file or class name
and description of purpose be included on the same "printed page" as the copyright notice for easier
identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance
with the License. You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed
on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See
the License for the specific language governing permissions and limitations under the License.
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